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Preface
Scope
This manual describes how to operate Version 2.0.0 of the GDC TEAM 5002 UNIX softw
application. The TEAM 5002 software employs Simple Network Management Protocol (SN
to configure and control the operation of GDC SpectraComm 5002 Line Terminating Unit
(LTUs). It can be launched under HP OpenView to run on a Sun Solaris workstation or a 
Hewlett-Packard HPUX platform. 

The SC 5002 LTU performs E1 network interface functions for a group of data set emulators 
(DSEs) installed with it in a SpectraComm shelf. The DSEs perform DTE interface functio

The TEAM 5002 application communicates with the LTU through a SpectraComm Manag
(SCM) card that also occupies the SpectraComm shelf. 

This manual assumes you are familiar with HP OpenView and with E1 digital transmission
ucts. 

Revision History
This is Issue 1 of the manual for TEAM 5002 Version 2.0.0. This version of the application
been upgraded to be compatible with Version 4.1 of the HP OpenView Operating System

Organization
This manual has five chapters:
Chapter 1, Introduction, provides a high-level overview of the TEAM 5002 system compone

Chapter 2, Operation, covers the two means of access to the TEAM 5002 applications: the shelf
map menu bar, and the Front Panel display Select button menus. The shelf map menu b
provides four selections in the Performance category, all of which are fully described in th
chapter: Front Panel, Reports, Alarms, and Current Interval Reports. Also fully described a
three applications that appear on the menu bar Misc menu: Information, Front Panel Poll
and Note Pad. This chapter also describes how to access the Configuration, Maintenanc
Diagnostics applications. 

Chapters 3, Configuration, provides detailed instructions for using the TEAM software to 
configure your Line Terminating Unit (LTU).

Chapter 4, Maintenance, documents three maintenance functions that you can use to set 
maintenance options for the LTU.

Chapter 5, Diagnostics, details the diagnostic tests that you may run on the LTU.
GDC 058R728-V200
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Document Conventions
This manual uses three levels of headings to organize information visually and logically.

Level 1 Headings
Level 1 paragraph headers introduce major topics.

Level 2 Headings

Level 2 paragraph headers introduce subsections of major topics.

Level 3 Headings

Level 3 paragraph headers introduce subsections of secondary topics.

Typefaces and Fonts

This typewriter font shows output that is displayed on the screen.

This bold font shows specific input that you type at the keyboard.

This bold italicized font shows variable input that you type at the keyboard.

Related Publications
The following documents have information that may be helpful when using this product:

GDC publication numbers (e.g., GDC 032R163-000) are used to track and order technical ma
uals.   Publication numbers use the following format: 

GDC NNNRnnn-000 or GDC NNNRnnn-Vnnn
• NNN identifies the product family (e.g., TEAM)

• R denotes a technical publication

• nnn a number assigned by Technical Publications

• 000 identifies a hardware product and does not change

• Vnnn the software version associated with a product may be updated periodically

The issue number on the cover only changes when a hardware manual is revised or when
ual is reprinted for some other reason; it does not automatically change when the software
dated.   A new Software Version is always Issue 1. Other specialized publications such as R
Notes or Addenda may be available depending on the product.

Notes present special instructions, helpful hints or general rules.

GDC Number Product

058R720-V160 TEAM Core Operation

058R723-V100 TEAM Software Server Configuration

076R112-000 SpectraComm 5002 LTU Installation & Operation

NOTE
GDC 058R728-V200
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1  Introduction
Overview
This manual covers the General DataComm TEAM 5002 Unix Application for HP OpenV
You should be familiar with HP OpenView and with E1 digital transmission products in or
to use this manual effectively. 

The TEAM 5002 Unix Application is actually a collection of integrated applications for the 
OpenView Network Management Platform. The applications use the Simple Network 
Management Protocol (SNMP) to manage GDC SC 5002 Line Terminating Unit (LTU) ca
which are part of a SpectraComm 5000 (SC 5000) system. 

TEAM 5002 applications enable you to 

• Configure SC 5002 LTUs. 

• Monito r the operation of the LTUs through an alarm display and through a Front Pa
display that shows LED indicators as they appear on the front panel of the physical

• Diagnose suspected problems using the test functions incorporated in the LTU. 

SC 5000 System Components
SC 5000 hardware consists of three types of components:

• Line Terminating Unit (LTU)

• Data Set Emulator (DSE)

• SpectraComm Manager (SCM)

Line Terminating Unit (LTU)

The Line Terminating Unit (LTU) performs network interface and channel grooming
functions for a group of DSEs. An SC 5002 LTU connects to a E1 line, over which i
transmits the combined data traffic of up to 30 DSEs to a Telco switching site. On th
line, the data for each DSE occupies one or more DS0s: an SC 5520 DSE employs a
DS0; an SC 5034 DSE employs two DS0s, one for each modem channel; an SC 555
can employ as many DS0s as its fractional E1 function requires, from 1 to 30. Telep
company switching equipment routes the DS0s of the E1 line from the SC 5000 site to
individual remote destinations. In this way a single E1 connection between an SC 5
site and a switching site can support voice grade or DDS connections (each occupyin
DS0) with up to 24 remote sites. Fractional E1 DSEs reduce the number of remote s
which one SC 5002 LTU can support links. 

Data Set Emulator (DSE)

The Data Set Emulator (DSE) performs DTE interface functions in a manner that emu
the operation of a traditional data set directly connected to a telephone line. For exa
an SC 5034 DSE supports two modem channels each of which appears to its DTE and t
GDC 058R728-V200
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its remote modem to be a V.34 modem; an SC 5520 DSE emulates the functions of a
NMS 520 Data Service Unit. Rather than being directly connected to a telephone com
network, however, each DSE transmits and receives data through a data highway 
incorporated in the backplane of the SpectraComm shelf. The data highway links the
to an LTU. Each DSE is managed by its own TEAM application. 

SpectraComm Manager (SCM)

SpectraComm Manager (SCM) acts as the SNMP agent through which TEAM 
management applications communicate with SC 5000 components. All managemen
communications are directed to the SCM card Internet Protocol (IP) address. The S
card relays commands and responses between management applications and hard
components, using a slot addressing scheme to communicate over the SpectraCom
backplane with the other SC 5000 components. The SCM is transparent to the applica
which operate as though they were communicating directly with the hardware units. 
SCM card is managed by the TEAM core application, which is also responsible for t
Discovery and Mapping functions by which HP OpenView keeps track of the devices b
managed. 

SC 5002 LTU
An SC 5002 LTU performs network interface functions for the SC 5000 system. On its net
side, it connects to an E1 line, composed of 32 DS0s. Thirty DS0s are available to carry use
enabling the LTU to transmit and receive at up to 1.9 Mbps. The LTU interfaces through t
SpectraComm shelf backplane data highway bus with a group of DSEs, each of which supplies 
data for one or more DS0s. 

The remaining two DS0s are used for network signaling (DS0 0) and framing (DS0 16). 

TEAM 5002 Applications
The applications that make up the TEAM 5002 manager are grouped on menus under the
headings Performance, Configuration, Fault, and Misc (Miscellaneous). Menus for the 
applications are available in two ways: 

• From the menu bar of the HPOV Map window when an SC 5002 LTU is selected in 
window 

• From the Select button on the SC 5002 Front Panel display. 

SC 5002 Front Panel displays current status information on the SC 5002 LTU by displayin
states of the LED indicators on the front panel of the unit; and provides Select button men
which you can invoke other functions of the TEAM 5002 manager. You can launch the Fro
Panel display from the HPOV Map window by means of the Front Panel selection in the 
Performance menu or by double clicking on the shelf icon of the LTU you need to work wi

The following TEAM 5002 applications appear on the Map window and Select button men

• Performance: 

Front Panel – launches the Front Panel display (selection appears only on Ma
dow menu).

Reports – launches the Error Reports window that displays an overview of oper
conditions and provides access to a selection of more detailed displays. 

Alarms – furnishes detailed information about alarm state changes.

Current Interval Reports – launches a display of the most recent operating conditions. 
GDC 058R728-V200
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• Configuration:

Configure – enables you to configure SC 5002 LTUs. 

Maintenance – enables you to set device specific attributes that are not set as c
uration options.

• Fault – enables you to run diagnostic tests on SC 5002 LTUs.

• Misc: 

Information – displays revision and copyright information for the application. 

Front Panel Poll Rate – enables you to adjust the rate at which the application
the LTU while the Front Panel display is on-screen. 

Note Pad – provides access to a text editor. 
GDC 058R728-V200
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2   Operations
Introduction
The TEAM 5002 controller application consists of a group of smaller applications, each de
to a specific aspect of controlling or monitoring the SC 5002 Line Terminating Unit. There
two means of access to the TEAM 5002 applications: the shelf map menu bar, and the Fron
Panel window Select button menus. This chapter describes both. 

On the shelf map menu bar there are four selections in the Performance category: Front 
Reports, Alarms, and Current Interval Reports. The Front Panel selection launches a dis
window that shows the state of indicators at the LTU. Reports displays accumulated statis
error conditions that have occurred. Alarms displays a read-only window by which you can
track of LTU alarm conditions. Current Interval Reports displays counts of events that ha
taken place during the present uncompleted 15-minute interval. The Front Panel selectio
doesn’t appear in the Performance category of the Front Panel window Select button menu
chapter fully describes all four of the Performance menu functions. 

There are two applications in the Configuration category: Configure and Maintenance ea
support read/write windows by which you can review and alter LTU operating parameters
chapter describes how to access the Configure and Maintenance applications. Instruction
using the two applications appear in subsequent, individual chapters. 

The Diagnose application, accessed through the Fault menu, supports a read/write window b
which you can command the test functions of the LTU and view test results. This chapter
describes how to access the Diagnostic application. Instructions for using the application appe
in a subsequent chapter. 

Three items appear on menus as Misc (miscellaneous): Information, which displays versio
copyright information on the application; Front Panel Poll Rate, which affects the Front P
display; and Note Pad. This chapter describes all three. 

Map Window Menu Bar Access
The table on the following page illustrates how the TEAM 5002 application functions are 
arranged on the menu bar at the top of the HPOV Map window. The table shows only the
selections for the TEAM 5002 applications. The map window menus include selections in
addition to those that apply to TEAM 5002 because the window also provides access to other
applications. 

You must select the LTU you intend to work with before you open the menu you intend to
Select the LTU by clicking the mouse on its icon in the shelf map.
GDC 058R728-V200
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The Performance menu Front Panel selection opens the Front Panel display window. The
button menus in the Front Panel display window include the selections that appear above
the exceptions of Front Panel in the Performance menu and the Front Panel Poll Rate an
Pad items in the Misc menu. 

SC 5002 LTU Front Panel
The SC 5002 Front Panel display window (See Figure 2-1) provides a graphical interface to a 
selected SC 5002 LTU. You can launch a Front Panel in either of two ways:

• select the unit you intend to work with in the HPOV Map window, then select Front P
from the Performance menu for that window

• display the shelf sub-map that includes the unit you intend to work with, then double 
the mouse on the slot icon for the unit. 

The application responds by displaying a window that depicts the front panel of the SC 5002
unit. 

Menu Bar Menu Selections

Performance

Front Panel

Reports...

Alarms...

Current Interval Reports...

Configuration

Configure... 

Maintenance... 

Fault

Diagnose... 

Misc

Information...

Front Panel Poll Rate...

Note Pad
GDC 058R728-V200
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Figure 2-1 SC 5002 LTU Front Panel

The LEDs shown in the display reflect the states of the actual indicators on the physical u

INS – In Service, indicates when lit that the unit is configured and operating

ON – Power On

TMG  – Timing, indicates when lit that the LTU is the source of 4 MHz timing for its sh

RSP – Response, indicates when lit that the LTU is transmitting a response to a netw
controller command 

LCV  – Line Code Violations, indicates when lit that the LTU has detected the alarm 
condition in which the signal being received does not alternate signal states as it sho

AIS – Alarm Indication Signal, indicates when lit that the LTU has detected a network 
(all ones) in the incoming E1 signal 

OOF – Out of Frame, indicates when lit that the LTU cannot synchronize to the E1 si

LOS – Loss of Signal, indicates when lit that the LTU is receiving no signal on the E1

TM  – Test Mode 

ALM  – Alarm, indicates by its color, which matches that of the SC 5002 Shelf submap
for the unit, that the LTU has detected an alarm condition 
GDC 058R728-V200
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The application polls the LTU to keep the states of the LEDs in the Front Panel display cu

The Select button at the bottom of the Front Panel display provides access to menus for t
of the TEAM 5002 application functions. 

The following table shows the arrangement of the Select button menus. It differs somewha
the arrangement on the Map window menu bar. 

The two Poll selections in the Select button menu determine when the application collects
information from the LTU to update the Front Panel window:

• Selecting Demand Poll causes an immediate update of the display. 

• Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disab
automatic polling. If you select Disable, the Front Panel window displays a static snap
of the LED states as they were at the last poll, either when the window was launche
subsequent Demand Poll. 

The menu selection Exit dismisses the Front Panel window when you click on it. 

Select Button Menu Selections

Performance

Alarms...

Reports...

Current Interval Reports...

Configuration

Configure...

Maintenance...

Fault

Diagnose...

Misc

Information...

Demand Poll

Auto Poll (*)

15 seconds

30 seconds

60 seconds

Disable

Exit * Displays Off or poll interval
GDC 058R728-V200
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Common Window Features
Each TEAM 5002 application you select opens an on-screen window in which to operate.
number of features are common to many of the windows: 

Triangle button – in the title bar; reduces the window to an icon when you click on it. Doub
clicking on icon restores the window. This button appears on the top leve
window for each application.

Title bar – identifies the specific TEAM 5002 application running in the window; for 
example TEAM 5002 Main Configuration or TEAM 5002 Diagnostics 

Menu bar – always contains the selections File, on the far left, and Help, on the far r
File menu always contains the selection Exit, by which you can dismiss th
window; some window File menus contain selections special to the windo
Help menu provide access to information concerning the window. Some 
windows have additional Menu bar selections. 

The Menu bar appears on the top level window for each application. A Menu 
bar appears in the Main Configuration window, for example, but not in the
windows you access from Main Configuration.

Name field – identifies the SC 5002 the application is currently connected to by displa
the user-configured shelf name, followed by the LTU slot number), and th
user-configured device name. 

Descriptions in this manual of the individual TEAM 5002 applications identify window featu
that are specific to the applications, such as selections in the Menu bar and menus, and b

Performance Functions
There are three functions that appear in both Performance menus, from the map window 
bar and the Front Panel display Select button. 

Reports

You can launch the TEAM 5002 Reports application from the Shelf Map Performance Men
from the Front Panel display Select button menu. The application displays statistics accum
by the LTU concerning five types of error conditions. 

When you launch the Report application it initially displays an Error Reports summary win
(see Figure 2-2) that displays statistics for all the error conditions the application tracks. Th
Navigate menu of the summary window provides access to individual windows that provide more 
detailed statistics on each error condition. 

The statistics displayed in the Error Reports summary window cover 48 hours of operation
divided into Current 24 Hours (excluding the current, incomplete 15-minute interval) and Re
24 to 48 Hours. For each of those periods the application indicates the number of occurren
five types of error event. The display shows paired graph bars for near-end and far-end E
Seconds, Severely Errored Seconds, Background Block Errors, and Unavailable Seconds
shows a single graph bar in each 24-hour display for near-end Line Code Violations. 

The TEAM 5002 Maintenance application, accessible through the Configuration menu, en
you to separately reset the counts of near-end and far-end statistics.

The vertical axis of the bar graph displays the number of error events against a selectable s
0 to 65000, 32500, or 16250. Click on the appropriate checkbox above the bar graph disp
select the vertical scale. 
GDC 058R728-V200
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Figure 2-2 Error Reports Window

Error Reports Window Menus

The Error Reports window has File and Navigate menus in its menu bar. 

The File menu consists of Refresh and Exit selections. The Refresh selection updates the 
to reflect changes that have occurred since the window was opened or since the last Refre
Exit selection dismisses the Error Reports window. 

The Navigate menu contains eight selections for detailed Error Reports displays: 

Errored Seconds (Graph)...

Severely Errored Seconds (Graph)...

Background Block Errors (Graph)...

Unavailable Seconds (Graph)...

Line Code Violations (Graph)...

Unavailable Time Periods (Text)...

Near End Errors (Text)...

Far End Errors (Text)...
GDC 058R728-V200
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The first five selections access graphic screens that are detail displays of the information 
presented in the main Error Reports window. The last three selections in the Navigate me
access text screens that display the exact numbers of error event occurrences. 

Errored Seconds Display Screen

The Errored Seconds display screen graphically illustrates the number of near-end and fa
errored seconds that have occurred in the last four hours. It also provides a numeric displ
how many near-end and far-end errored seconds occurred in the last two 24-hour periods

Figure 2-3 Errored Seconds Reports Display Screen 

Time intervals are the horizontal axis of the bar graph display. There are 18 pairs of graph
each displaying a blue bar for the near-end value and a cream colored bar for the far-end
The pairs of graph bars are identified as 0 through 16 and Avg: 

• 0 indicates the number of errored seconds that have occurred so far in the current, 
incomplete 15-minute interval 

• 1 through 16 represent the latest four-hour time span, divided into 15-minute interva

• Avg illustrates the averages of the 16 values for completed intervals. 

The vertical axis of the bar graph displays the number of errored seconds against a selectab
of 0 to 900, 450, or 225. Click on the appropriate checkbox above the bar graph display to
the vertical scale. 
GDC 058R728-V200
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Two sets of 24-hour totals appear below the bar graph display: 

• Near-end and far-end total errored seconds for the most recent 24 hours 

• Near-end and far-end total errored seconds for the preceding 24 hours (25 to 48 hour

Click on the OK button to dismiss the window when done viewing it. 

Severely Errored Seconds Display Screen

The Severely Errored Seconds display screen graphically illustrates the number of near-e
far-end severely errored seconds that have occurred in the last four hours. It also provide
numeric display of how many near-end and far-end severely errored seconds occurred in t
two 24-hour periods. 

Figure 2-4 Severely Errored Seconds Reports Display Screen 

Time intervals are the horizontal axis of the bar graph display. There are 18 pairs of graph
each displaying a blue bar for the near-end value and a cream colored bar for the far-end
The pairs of graph bars are identified as 0 through 16 and Avg: 

• 0 indicates the number of severely errored seconds that have occurred so far in the c
incomplete 15-minute interval 

• 1 through 16 represent the latest four-hour time span, divided into 15-minute interva

• Avg illustrates the averages of the 16 values for completed intervals. 
GDC 058R728-V200
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The vertical axis of the bar graph displays the number of severely errored seconds agains
selectable scale of 0 to 900, 450, or 225. Click on the appropriate checkbox above the bar
display to select the vertical scale. 

Two sets of 24-hour totals appear below the bar graph display: 

• Near-end and far-end total severely errored seconds for the most recent 24 hours 

• Near-end and far-end total severely errored seconds for the preceding 24 hours (25
hours ago). 

Click on the OK button to dismiss the window when done viewing it. 

Background Block Errors Display Screen

The Background Block Errors display screen graphically illustrates the number of near-en
far-end background block errors that have occurred in the last four hours. It also provides
numeric display of how many near-end and far-end background block errors occurred in th
two 24-hour periods. 

Figure 2-5 Background Block Errors Reports Display Screen 

Time intervals are the horizontal axis of the bar graph display. There are 18 pairs of graph
each displaying a blue bar for the near-end value and a cream colored bar for the far-end
The pairs of graph bars are identified as 0 through 16 and Avg: 

• 0 indicates the number of background block errors that have occurred so far in the cu
incomplete 15-minute interval 

• 1 through 16 represent the latest four-hour time span, divided into 15-minute interva
GDC 058R728-V200
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• Avg illustrates the averages of the 16 values for completed intervals. 

The vertical axis of the bar graph displays the number of background block errors against
selectable scale of 0 to 65000, 32500, or 16250. Click on the appropriate checkbox above 
graph display to select the vertical scale. 

Two sets of 24-hour totals appear below the bar graph display: 

• Near-end and far-end total background block errors for the most recent 24 hours 

• Near-end and far-end total background block errors for the preceding 24 hours (25 t
hours ago). 

Click on the OK button to dismiss the window when done viewing it. 

Unavailable Seconds Display Screen

The Unavailable Seconds display screen graphically illustrates the number of near-end an
end unavailable seconds that have occurred in the last four hours. It also provides a nume
display of how many near-end and far-end unavailable seconds occurred in the last two 2
periods. 

Figure 2-6 Unavailable Seconds Reports Display Screen 

Time intervals are the horizontal axis of the bar graph display. There are 18 pairs of graph
each displaying a blue bar for the near-end value and a cream colored bar for the far-end
The pairs of graph bars are identified as 0 through 16 and Avg: 

• 0 indicates the number of unavailable seconds that have occurred so far in the curre
incomplete 15-minute interval 
GDC 058R728-V200
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• 1 through 16 represent the latest four-hour time span, divided into 15-minute interva

• Avg illustrates the averages of the 16 values for completed intervals. 

The vertical axis of the bar graph displays the number of unavailable seconds against a sel
scale of 0 to 900, 450, or 225. Click on the appropriate checkbox above the bar graph disp
select the vertical scale. 

Two sets of 24-hour totals appear below the bar graph display: 

• Near-end and far-end total unavailable seconds for the most recent 24 hours 

• Near-end and far-end total unavailable seconds for the preceding 24 hours (25 to 48 hours 
ago). 

Click on the OK button to dismiss the window when done viewing it. 

Line Code Violations Display Screen

The Line Code Violations display screen graphically illustrates the number of near-end line
violations that have occurred in the last four hours. It also provides a numeric display of h
many near-end line code violations occurred in the last two 24-hour periods. 

Figure 2-7 Line Code Violations Reports Display Screen 

Time intervals are the horizontal axis of the bar graph display. There are 18 graph bars, ide
as 0 through 16 and Avg: 

• 0 indicates the number of line code violations that have occurred so far in the curren
incomplete 15-minute interval 
GDC 058R728-V200
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• 1 through 16 represent the latest four-hour time span, divided into 15-minute interva

• Avg illustrates the averages of the 16 values for completed intervals. 

The vertical axis of the bar graph displays the number of line code violations against a sele
scale of 0 to 65000, 32500, or 16250. Click on the appropriate checkbox above the bar gr
display to select the vertical scale. 

Two 24-hour totals appear below the bar graph display: 

• Total near-end line code violations for the most recent 24 hours 

• Total near-end line code violations for the preceding 24 hours (25 to 48 hours ago). 

Click on the OK button to dismiss the window when done viewing it. 

Unavailable Time Periods Display Screen

The Unavailable Time Periods display screen lists the last six periods of unavailability for 
the near and far ends. Each time period is specified by its Start time, End time, and Durat

Click on the OK button to dismiss the window when done viewing it. 

Figure 2-8 Unavailable Time Periods Reports Display Screen 

Near End Errors Display Screen

The Near End Errors display screen is the text equivalent of the near end portion of the E
Reports graphical display screen. It displays a variety of information on the five types of e
event that can be detected at the near-end unit. 
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Figure 2-9 Near End Errors Reports Display Screen 

The screen displays two Total Error Events categories, each of which shows total events 
24-hour period: 

• Recent 24 Hours (covering the timespan from 25 to 48 hours ago

• Current 24 Hours (without Current Interval) 

The display headed Current Error Events: One 15 Minute Interval show the error events 
accumulated thus far in the uncompleted current interval. On the 15-minute boundary the 
accumulation is transferred to the Current 24 Hours count and a new current interval begi

The Cumulative Error Events display at the bottom of the screen presents a detailed view o
events that have occurred over the most recent four hours. The four rows of the display rep
the four hours; the 1st through 4th quarters of the hours appear as columns under each of t
events. As each current interval is completed, its accumulated count appears here as the v
Hr 1/1st. All previous counts shift one place down; the previous value for Hr 4/4th is bump
from the display. 

Click on the OK button to dismiss the window when done viewing it. 

Far End Errors Display Screen

The Far End Errors display screen is the text equivalent of the far end portion of the Error R
graphical display screen. It displays a variety of information on the four types of error even
can be detected at the far-end unit. The far end display does not include Line Code Violat
which does appear in the near end display. 
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Figure 2-10 Far End Errors Reports Display Screen 

The screen displays two Total Error Events categories, each of which shows total events 
24-hour period: 

• Recent 24 Hours (covering the timespan from 25 to 48 hours ago

• Current 24 Hours (without Current Interval) 

The display headed Current Error Events: One 15 Minute Interval show the error events 
accumulated thus far in the uncompleted current interval. On the 15-minute boundary the
accumulation is transferred to the Current 24 Hours count and a new current interval begi

The Cumulative Error Events display at the bottom of the screen presents a detailed view o
events that have occurred over the most recent four hours. The four rows of the display rep
the four hours; the 1st through 4th quarters of the hours appear as columns under each of t
events. As each current interval is completed, its accumulated count appears here as the v
Hr 1/1st. All previous counts shift one place down; the previous value for Hr 4/4th is bump
from the display. 

Click on the OK button to dismiss the window when done viewing it. 

Alarms

You can launch the TEAM 5002 Alarm application from the HPOV Map Performance Men
from the front panel menu. The application displays the read-only Alarms Detail window fo
selected LTU (See Figure 2-11).

The TEAM 5002 application gets alarm indications from the LTU in two ways: 

• By receiving traps that the SCM sends automatically in response to alarm conditions at the
LTU

• By polling the SCM for changes in alarm conditions at the LTU.
GDC 058R728-V200



Operations 2-15

are 

urce

e

e E1 

at the 

CRC 

ore 

 LTU 
Figure 2-11 Alarm Detail Window

The Alarm Detail window displays alarms grouped into three categories: 

Major

• NV RAM Corrupt – occurs when the LTU computes an incorrect checksum for its softw
configuration

• Unit Failure – occurs when the LTU fails to pass its Power On Self Test

• Timing Loss – occurs when the LTU loses timing from its configured transmit clock so

• Loss of Signal – occurs when the LTU detects absence of signal on the E1 line

• Loss of Frame – occurs when the LTU cannot synchronize to the signal on the E1 lin

• Alarm Indication Signal – occurs when the LTU receives an AIS (all ones) signal on th
line

Minor

• Near End Unavailable Seconds – occur when a Severely Errored Second condition 
local LTU persists for ten seconds or more 

• Near End Errored Seconds – occur when the local LTU detects at least one LCV or 
error event in the signal it is receiving 

• Near End Severely Errored Seconds – occur when the local LTU receives 30% or m
error-containing blocks, or receives an AIS signal, or suffers an OOF condition 

• Near End Background Block Errors – is a count of the number of data blocks the local
has received that contain detectable errors 
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• Near End Line Code Violations – occurs when the signal the local LTU receives at it
interface does not alternate between signal levels as required for HDB3 data encodi

• Far End Unavailable Seconds – occur when a Severely Errored Second condition a
remote unit persists for ten seconds or more 

• Far End Errored Seconds – occur when the remote unit detects at least one LCV or
error event in the signal it is receiving 

• Far End Severely Errored Seconds – occur when the remote unit receives 30% or m
error-containing blocks, or receives an AIS signal, or suffers an OOF condition 

• Far End Background Block Errors – is a count of the number of data blocks the remot
has received that contain detectable errors 

Informational 

• Power Up – occurs when the LTU is powered on or undergoes a system reset 

• Fallback Timing Active – occurs when the LTU is operating using its configured fallb
timing source 

Alarm Detail Window Menus

The Alarm Detail window has a File menu and a View menu in its menu bar. 

The File menu contains only the selection Exit, by which you can dismiss the window. 

The View menu consists of three selections: Major, Minor, and Informational, each with a c
box beside it. To remove an alarm category from the window display, click on its check bo
that it is unchecked. Clicking a box so that it is checked restores the corresponding catego
the display. 

Current Interval Reports

You can launch the TEAM 5002 Current 15 Minute Interval Error Report application from 
map window Performance menu or from the Front Panel display Select button menu. The p
of the application is to display “snapshot” views of statistics accumulated by the LTU durin
incomplete current interval. 

The application acquires the statistics it displays on operator command, rather than automa
The window provides two buttons for this purpose below the display area: Read Near End
Read Far End. A “% Interval Measured” bar graph below each read button indicates how 
of the 15-minute interval had elapsed when the data currently on display was collected. T
display shows only the most recently read information, not simultaneous near-end and far
data. 

The application displays statistics concerning five types of error conditions divided into two
of graph bars:

• Errored Seconds (ES), Severely Errored Seconds (SES), and Unavailable Seconds 
displayed against a selectable vertical scale that extends from 0 to 900, 450, or 225 s

• Background Block Errors (BBE) and Line Code Violations (LCV) displayed against a
selectable vertical scale that extends from 0 to 65000, 32500, or 16250 events (LCV
displayed only for the near end)

The Set Vertical Scale checkboxes at the top of the window enable you to select the secon
events scales together: 900/65000, 450/32500, or 225/16250. 

Below the graph bars the window displays numeric counts of the error conditions. 
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When viewing this window, you should perform a new read every few minutes to get a sen
how frequently error events are occurring. Remember that the statistics all reset to zero at t
of each 15-minute current interval. 

When you are done viewing the Current Interval Error Report window, select Exit from the
menu to dismiss the application. 

Figure 2-12 Current Interval Error Report Window

Configuration Functions
Configure

You can launch the TEAM 5002 Configuration application from the map window Configura
Menu or from the Front Panel Select button menu. 

When you launch the application, it initially displays the read-only TEAM 5002 Configurati
window, which has a File menu and a Navigate menu in its menu bar. 

The File menu contains selections for loading and saving configurations:

• Refresh, by which you can discard pending (unsaved) configuration changes
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• Save to Unit, which puts configuration changes into effect in the LTU 

• Load Template, by which you can recall an LTU configuration saved as a template o
workstation

• Save to Template, by which you can save an LTU configuration on the workstation 

• Compare to Template, by which you can check for differences between the current 
configuration and a stored template 

• Exit, by which you can dismiss the window. 

The Navigate menu enables you to access the read/write windows by which you can conf
various aspects of operation: 

• System Options

• Alarms Reported

The TEAM 5002 Configuration application is fully described in Chapter 3, Configuration. 

SC 5002 Maintenance
You can launch the TEAM 5002 Maintenance application from the map window Configura
Menu or from the Front Panel Select button menu. 

The application displays one read/write window by which you can control some aspects o
operation that fall outside the scope of Configuration. The TEAM 5002 Maintenance applic
is fully described in Chapter 4, Maintenance. 

Diagnostics
You can launch the TEAM 5002 Diagnostics application from the map window Fault menu
from the Front Panel Select button menu. 

The application displays one read/write window by which you can control a variety of test 
functions on the LTU. The TEAM 5002 Diagnostics application is fully described in Chapter 5, 
Diagnostics. 

Miscellaneous 
The menu category Misc (miscellaneous) contains three functions when you access it from
map window menu bare, and only one when you access it from the Front Panel display S
button menu. The Information function is accessible in both ways. The Front Panel Poll Ra
Note Pad functions can only be called from the map window menu bar. 

Information

You can launch the TEAM 5002 Information window from the Misc menu of either the ma
window or the Front Panel display Select button. You can also launch it by clicking on the 
logo in the Front Panel display. 

Information displays one read-only window that contains the name of the application, soft
revision level information, and copyright information. The File menu in the menu bar conta
only the selection Exit, by which you can dismiss the window. 
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Figure 2-13 TEAM 5002 Information Window

Front Panel Poll Rate

You can open the Front Panel Poll Rate window (See Figure 2-14) from the Misc menu of the 
Map window. The setting you select in this window determines the initial polling rate for F
Panel displays each time they are opened. 

The rate selection is a global function. It selects initial polling rate for all front panel displa
linked to a TEAM Core application, regardless of which individual application you access it 
from. 

There are four selections, each accompanied by a checkbox: 

Slow 

Normal 

Fast 

Demand Poll Only 

The File menu in the menu bar contains two selections: Save to File and Exit. 

To set the desired polling rate, first click on the appropriate checkbox and then select Save
from the File menu. The precise polling frequency that results from a setting of Slow, Norm
Fast depends on a number of factors. The higher the rate, the more communication and pr
capacity is devoted to maintaining the display. 

The polling rate for an individual front panel display can be changed for the duration of a se
by means of the Auto Poll selection in the Select button menu. Changes you make with tha
selection are not retained when the display is closed. 

To dismiss the window, select Exit from the File menu. 

Figure 2-14 Front Panel Poll Rate Window
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You can launch the Note Pad application from the Misc menu of the Map window. The 
application opens a shell tool on the workstation running the TEAM software. You can use
shell tool to run a text editor, mail tool, or any other software that resides on the workstation
Note Pad application provides this access for keeping records on the system. 
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3   Configuration
Introduction
The TEAM 5002 Configuration application enables you to set all the options in the SC 5002
Terminating Unit through a convenient group of configuration windows. 

To Start TEAM 5002 Configuration 
You can start the TEAM 5002 Configuration application by either of two methods: 

• Select an LTU symbol on the shelf submap in OpenView, then select the Configura
option from the Administer menu. 

• Click on the Select button of the Front Panel display, then click on Administer and s
Configure from the resulting menu. 

Templates
You can store configuration settings as templates on the workstation that runs the TEAM
application. A template stores a complete configuration for all the LTU options, and you c
store as many templates as you need. 

To load configuration settings from a template into the LTU you must perform the followin
steps: 

1. Select Load Template from the File menu and select the template from the resulting 
window. The application retrieves the configuration settings of the selected templat

2. Select Save to Unit from the File menu. The application makes the template configu
settings the current operating configuration for the LTU. 

Configuration Procedure
The following steps describe how to use the configuration application, and illustrate the 
functions of the Main Configuration window menus. 

1. Access the Main Configuration window, either from the submap or from the Front P
display. The application reads the current Main configuration from the LTU when
open the Main window. 

You can select to base your configuration changes on either the current configuratio
stored configuration template. In either case, the LTU continues to operate using its
unchanged current configuration. 

The Refresh selection on the Main window File menu causes the application to read th
current configuration from the LTU. All changes to all configuration windows that ha
not previously been saved to the LTU or a template are lost when you select Refres

2. To edit the current configuration of the LTU, proceed directly to the Navigate menu a
scribed below. 
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To edit a template, select Load Template from the File menu and select a template from
the resulting list. 

3. Click on the Navigate button to display a menu of the configuration windows, and sel
the one in which you intend to make changes. 

4. Make changes as needed in the configuration window. When you click on the inpu
for an option, a window opens to display all the values the field can be set to. Clic
mouse on the value you select. When you change the value or setting of an option, 
plication displays the option name and the new value in white, rather than black, type
remain white until you either save the changes to the LTU or a template by means
Main window File menu, or restore the option to its last stored value or setting. 

You can discard changes to a configuration window and return all its fields to their st
values in two ways:

• Click on the Reset button to discard changes while keeping the window 
open

• Click on the Cancel button to discard changes and close the window. 

You can close a configuration window without losing changes by clicking on either theOK 
button or the pushpin icon, which is located in the upper left corner of the window.

You can keep multiple configuration windows open on-screen and move between the
clicking the mouse on the one in which you intend to operate. The Main Configuratio
window remains on-screen throughout the configuration process. 

5. When you have accessed all the configuration windows that you need to and made
your changes, click on the File menu button of the Main Configuration window. From tha
menu you can select Save to Unit to save the new configuration in the LTU, or select Save
to Template to save it as a template in the workstation. 

When you select Save to Unit, the changed configuration becomes the current 
configuration for the LTU. 

6. When you select Save to Template, a window appears containing a list of existing tem
and a field for entering a new template name. You can select an existing template
overwritten with the new configuration, or enter a name to create a new template. A 
template is available to be loaded by the application and then saved, with or without f
modification, to any SC 5002 LTU. 

Configuration Option Values

When you click the mouse on the entry field for a configuration item, a window opens conta
all the values that are permitted for that configuration item. Hold down the mouse button un
highlight is on the value you intend to configure, then release the button. The newly selected
appears in the entry field for the configuration item. 

Main Configuration Window
The Main Configuration window has two pull down menus, File and Navigate, that are the m
by which you carry out the actual process of configuring the LTU. From the Navigate menu you 
select the configuration windows in which you make changes. It has selections for the thre
individual configuration windows, and an All Screens selection that opens all three window
together. The File menu commands the storage and retrieval of configuration settings. The 
contents of the two menus appear below. 
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The Main Configuration window title bar displays the application name, TEAM 5002 
Configuration, followed by the shelf name, and the slot number of the LTU that is selected
configured. The main body of the window contains read-only items that identify the LTU a
provide information about its operations. 

Main Configuration Window Read-Only Display

The Main Configuration window displays the following read-only items:

Name: user-configured name for the LTU 

Slot State: Active or Inactive

Operational Status: On Line or Off Line

Serial Number: serial number of the LTU

Firmware Revision: revision level of the LTU operating code

MIB Version: revision level of the MIB files that enable SNMP control 

The TEAM 5002 application relies on the SCM and SC 5002 LTU to indicate when a 
configuration problem has caused an SNMP set error. 

Menu Buttons Menu Selections Further Selections

File

Refresh

Save to Unit

Load Template dialog window

Save to Template dialog window

Compare to Template dialog window

Exit

Navigate

System Options...

Alarms Reported... 

All Screens... 
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Figure 3-1 Main Configuration Window

System Options
The System Options configuration window contains two options concerned with how the L
operates on the E1 line. 

Figure 3-2 System Options Configuration Window

E1 Signalling Mode – selects whether or not the LTU calculates a Cyclic Redundancy Check
(CRC) for each frame as it is received at the network interface. 

Options:

Associated Channel with CRC4 

Associated Channel without CRC4

Response Timeout – selects the length of time the SCM waits for a response from the LTU
fore declaring a no response alarm. 

Options:

2 Seconds
4 Seconds
6 Seconds
8 Seconds
GDC 058R728-V200
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Alarms Reported
The Alarms Reported configuration window (Figure 3-3) lets you configure which alarm 
conditions are to be reported for the LTU and which are not.

Figure 3-4 Alarms Reported Configuration Window

Buttons and Option Selection

Each of the alarm options in the Alarms Reported configuration window has a small selec
field located to its left. You can select or de-select individual alarm options by simply click
the mouse button on the appropriate selection fields. When an option is selected for its ala
be reported, its selection field is highlighted. The selection fields next to alarm options tha
not to be reported are not highlighted. 

The Alarms Reported configuration window has two buttons positioned above the option f
Report All and Report None:
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• Click on Report All to highlight all the alarm option selection fields. 

• Click on Report None to remove the highlight from all the alarm option selection field

After clicking Report All or Report None you can then change the state of individual fields
needed. 

Alarms Reported Buttons

Report All  – unmasks all LTU alarms.

Report None – masks all LTU alarms.

OK  – saves your changes and closes the window.

Reset – replaces the information in the fields with the most recently read information from 
LTU. Note that this button does not initiate a read of information from the LTU.

Cancel – cancels your changes and closes the window.

Alarms Reported Fields

Declared Alarms

Alarm Indication Signal  – occurs when the LTU receives an AIS from the network.

Timing Loss – occurs when the LTU loses its source of Network Transmitter Timing. 

Fallback Timing Active – occurs when the LTU is using its configured fallback source of N
work Transmitter Timing.

Loss of Frame – occurs when the LTU misses two out of four framing bits in the signal com
from the network. The count for this alarm increments by one each time framing is lost, rega
of the number of frames affected. 

Loss of Signal – occurs when the LTU detects an absence of network signal. Absence of s
for a time equivalent to 175 bits (± 75) is considered no signal. 

Performance Alarms

If you unmask a Performance alarm you must designate a window and a threshold for it. Th
dow defines a time period within which the threshold must be exceeded in order for the LT
generate the alarm. For example, a window of one minute and a threshold of >100 specify
more than 100 alarm events must be detected within the one minute window before an al
generated.

Near End/Far End Unavailable Seconds – occur in response to 10 consecutive severely erro
seconds. The state is considered cleared when the LTU has processed 10 consecutive se
data without a severely errored second. 

Near End/Far End Errored Seconds – are any seconds during which the LTU detects at le
one Line Code Violation or Cyclic Redundancy Checksum error in its received signal. 

Near End/Far End Severely Errored Seconds – are any seconds during which at least one 
the following is true

30% of received blocks contain errors

Alarm Indication Signal is received

Out of Frame condition occurs
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Near End/Far Background Block Errors – are a count of received data blocks that contain e
rors. 

Near End Line Code Violations – occur when the signal the LTU receives at its network int
face does not alternate between signal levels as required for HDB3 data encoding. 
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4   Maintenance
Introduction
The TEAM 5002 Maintenance application provides four reset functions: two for statistics 
collection functions and two that directly affect operation of the SC 5002 Line Terminating U

To Start TEAM 5002 Maintenance 
You can start the TEAM 5002 Maintenance application by either of two methods: 

• Select an LTU symbol on the shelf submap in OpenView, then select Maintenance 
the Administer menu. 

• Click on the Select button of the Front Panel display, then click on Administer and s
Maintenance from the resulting menu. 

The window title bar displays the application name, TEAM 5002 Maintenance. The Name
displays the shelf and slot identification for the DSE. See Figure 4-1.

The pull-down File menu contains only the selection Exit, by which you can dismiss the win

Figure 4-1 Maintenance Window
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Maintenance Procedure
1. Access the Maintenance window, either from the Shelf Map menu bar or from the 

Panel display. 

2. Click the mouse on the button for the type of reset you need to perform. 

Maintenance Window Buttons
The buttons in the Maintenance window perform the following functions: 

Reset Near End Statistics – clears all data accumulated for near end line statistics reports,
begins new counts. 

Reset Far End Statistics – clears all data accumulated for far end line statistics reports, and
begins new counts. 

Reset to Factory Defaults – causes all options in the LTU to return to their factory default 
settings. When you click on this button the application displays a warning “Resetting to fa
defaults will disrupt communications to the unit. Do you want to continue?” Click on the OK 
button in the warning window to complete the reset, or click on the Cancel button to cance
reset. 

Soft Reset – causes the LTU to perform a reset and resume operation using its current 
configuration. When you click on this button the application displays a warning “Performin
soft reset will disrupt communications to the unit. Do you want to continue?” Click on the O
button in the warning window to complete the reset, or click on the Cancel button to cance
reset. 
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5 Diagnostics
Introduction
The TEAM 5002 Diagnostics application enables you to perform a variety of tests on the 
5002 LTU. 

Diagnostics Window

Figure 5-1 Diagnostics Window

The Diagnostics window, shown in Figure 5-1, is divided into four functional areas:

• Name field – identifies the selected LTU 

• Test control panel – by which you can select the diagnostic test and command it to 

• Graphic panel (unlabeled) – depicts the path followed by test data during the curren

• Time/Results panel – contains Stop Test button, and Time Remaining and Test Re
display fields
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The File menu contains only the selection Exit, by which you can dismiss the TEAM 5002 
Diagnostics window. The Navigate menu contains only the selection History, which provid
access to the Diagnostic History window. The history window is described later in this cha

E1 Line Loopback
The E1 Line Loopback test causes the LTU to loop received data back in the network interface
as transmit data as illustrated in Figure 5-2. The Test Mode (TM) indicator on the LTU front pan
el is lit while the loopback is active. 

The test connects receive to transmit in the analog portion of the network interface. The LTU
not correct bipolar violations and framing errors while a Line Loopback is in effect. 

Figure 5-2 E1 Line Loopback

Unit Self Test
The Unit Self Test establishes a Local Test loopback and directs an internally generated t
nal through the LTU. The LTU is isolated from the backplane data channels during the tes

Figure 5-3 illustrates the Unit Self Test. The Test Mode (TM) indicator on the LTU front pa
is lit while the test is active. 

During Unit Self Test:

• The LTU loops the transmit signal back to the receive path at the Network Interface.

• The LTU enables its internal Test Pattern Generator to provide the signal for the Loca
loop. 

• The LTU enables its Test Pattern Checker to verify the signal. 

The Unit Self Test takes approximately 15 seconds to run. Upon completion the Test Result
of the Diagnostics window displays either "Pass" or "Fail.” 

Network
Interface

SC 5002 LTU

Interface
to

Backplane 
Data

Highways

E1 Line Loopback
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Figure 5-3 Unit Self Test

Diagnostics History
You can view a record of tests performed during the current diagnostic session by selectin
History from the Navigate menu in the TEAM 5002 LTU Diagnostics window. The record 
appears as a listing in the Diagnostics History window (see Figure 5-4).

Figure 5-4 Diagnostics History window

The Diagnostics History window displays information in three columns

For a test that does not employ an LTU-supplied test pattern, such as a loopback to the fa

Start Time day, date, and time test began

Test the test conducted

Test Results the test result. OK is displayed for a test that does not 
involve a test pattern supplied by the LTU or for a 
test with a test pattern in which no errors occurred. 
Bit Errors is displayed, followed by a bit error num-
ber, for a test with a test pattern in which errors were 
found.

Network
Interface

SC 5002 LTU

Interface
to

Backplane 
Data

Highways

TPG

TPG

TPG – Test Pattern Generator
TPC – Test Pattern Checker
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OK in the Test Results column indicates only that the test mode was initiated successfully.
these test modes provide the data path for a test signal without generating or checking the
the application has no error rate data to display for them.

To close the Diagnostics History window, click on the pushpin icon in the upper left corner o
window or the OK button at the bottom. During an ongoing diagnostic session, you can clos
re-open the Diagnostics History window without loss of display data.

The application clears the Diagnostics History window when you exit from the diagnostics
window.
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